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Abstract 
Floodplain Visualization on TINs 

 
by 
 

Esteban Azagra, M.S.E. 
The University of Texas at Austin, 1999 

 
Supervisors: David Maidment and Francisco Olivera 

 

For more than thirty years, computer models have been used as essential tools for 

floodplain determination. Although the combined use of hydrologic and hydraulic 

models has significantly increased the ability to predict flooding events, the amount 

of fieldwork required to create and calibrate a model is still considerable. This 

document presents a methodology that uses aerial mapping as a basis for creating 

floodplain maps when using the HEC River Analysis System (HEC-RAS) hydraulic 

model for floodplain analyses. The approach is based on the use of triangular 

irregular networks (TINs) within a geographic information system (GIS) 

environment. 

This methodology was applied to the Waller Creek watershed in Austin, Texas, and 

involved three phases. First, flow data required by HEC-RAS were determined using 

the GIS-based application CRWR-PrePro and the hydrologic model HEC Hydrologic 

Modeling System (HEC-HMS). During the second phase, tools were developed for 

embedding structures, such as buildings, into the TIN. Finally, the ArcView GIS 

extension AVRas was used to extract the information contained in the TIN, export it 

into HEC-RAS, read the results of the hydraulic model and represent the flooded 

areas. Two and three dimensional animations were developed to show the 

visualization capabilities offered by GIS. Both, the comparison of the geometric data 

extracted from a digital representation of the terrain with field data, and the resulting 

model, show that TINs can be successfully used for floodplain determination and 

representation purposes. 
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1 Chapter 1: Introduction 

Floodplain modeling and mapping helps engineers prevent and predict damage. 

Computer models assist in the floodplain determination process in three ways. First, a 

hydrologic model converts the rainfall into runoff and, eventually, into flow within 

the streams. Second, a hydraulic model calculates the values of the water elevation at 

different points along the streams. Finally, the computed elevations are plotted on 

paper maps. Unfortunately, computer models require extremely detailed terrain 

information that involves large amounts of fieldwork. Furthermore, water surface 

elevations maps are usually plotted by hand in a tedious and potentially inaccurate 

task. Addressing these two limitations would improve floodplain analysis capabilities, 

reducing costs and improving the accuracy of the results. 

Recent developments of geographic information systems (GIS)–based tools have 

addressed these limitations. As shown in the literature review included in this chapter, 

some applications, working in combination with hydrologic and hydraulic models, 

reduce the need for field survey data and make the floodplain mapping process more 

automated. One of these applications is AVRas, a tool created by the Environmental 

Systems Research Institute (ESRI) and the Hydrologic Engineering Center (HEC), 

which uses triangular irregular networks (TINs) as the source of terrain information. 

This research involved the integration of two models – the HEC Hydrologic Modeling 

System (HEC-HMS) hydrologic model and the HEC River Analysis System (HEC-

AS) hydraulic model – with AVRas, to develop a regional model for floodplain 

determination and representation. 
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1.1 Objectives 

The primary research objective was to validate existing floodplain determination and 

visualization tools that use terrain information extracted from TINs. Attaining this 

objective required the completion of a series of steps: 

1. Use of the GIS-based application CRWR-PrePro and HEC-HMS to calculate 

the flow values corresponding to different amounts of rainfall in a given area. 

2. Extraction of terrain information from the TIN, validation of the information 

using existing field data, and translation of these data into a HEC-RAS format. 

3. Application of HEC-RAS to determine surface water elevation values from 

flow values and geometric information of the streams. 

4. Floodplain mapping in ArcView GIS and development of two and three 

dimensional animations for visualization purposes. 

The fulfillment of these tasks demanded the management of large amounts of data 

stored in different formats. Tools required for data processing and management were 

already available in most cases. For other situations – such as the integration of 

buildings into the TINs – specific solutions were required. 

1.2 Study Area 

The area selected for the project was the Waller Creek watershed in Austin, Texas 

(Figure 1-1). This area was selected for three reasons: First, it was located within an 

urban area in the City of Austin, making a floodplain study very appropriate to 

prevent damage. Second, it provided a branched stream network (something desirable 

to test the procedure) with enough simplicity to allow rapid computations during the 

modeling processes. Finally, previous work in this area supplied enough data to 

accomplish the analysis.  
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Figure 1-1. Waller Creek location in Austin, TX. 

1.3 Literature Review 

Although hydrologic and hydraulic computer models have been used for floodplain 

determination purposes during the last 30 years, only recent advances in the 1990s 

have made possible the use of GIS technology to improve the capabilities of those 

models. 

Jenson and Dominique (1988) and Jensen (1991) suggested an approach to delineate 

watershed boundaries and stream networks using geographic information extracted 

from digital elevation models (DEM). Functions that use the Jensen and Dominique 

algorithms to delineate streams and watersheds were soon available through the 

ArcView extensions Spatial Analyst and Watershed Delineator, both distributed by 

ESRI. 
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Hellweger and Maidment (1997) accomplished an important advance in the 

integration of hydrologic models and GIS, with the development of a GIS-based tool 

named HECPREPRO. The tool consists of a compilation of Arc/Info Language 

scripts (AMLs) used to pre-process and export spatial data into HEC-HMS, a widely 

used hydrologic package with a variety of options for simulating rainfall-runoff 

processes. Maidment, Olivera and Reed (1998) developed the CRWR-PrePro. This 

new tool combines the terrain analysis capabilities of the Watershed Delineator with 

the topologic capabilities of HEC-PrePro, adding the ability of computing attributes 

specific to a chosen hydrologic method. 

In the area of hydraulic modeling, approaches for linking hydraulic models and GIS 

have resulted in different tools to extract the hydraulic parameters from a terrain 

model and import them into a hydraulic model. More recently, those tools also allow 

for the display and analysis of floodplain maps in GIS. Beavers (1994) succeeded in 

creating ARC/HEC2, an interface connecting the HEC-2 hydraulic model with 

Arc/Info built on AML and C code. The interface extracts terrain information from 

contour coverages and exports the data into HEC-2. Afterwards, the program 

retrieves the results from the execution of HEC-2 and prepares an Arc/Info-based 

floodplain representation. Evans (1997) created a set of Arc/Info AMLs and 

associated programs adapted to work with HEC-RAS to create floodplain maps. In 

1998, ESRI translated and improved Evans’ code – making it compatible with 

ArcView – and added some utilities to facilitate its use. The result was called AVRas. 

Although appropriate for watershed delineation purposes, the degree of detail 

necessary for hydraulic modeling makes the use of DEMs inadequate. Most of the 

packages utilize TINs as the source of the parameters required for design flow 

calculations, but the accuracy required within the stream channel is not always 

satisfied. Tate (1999) approached this problem by developing a methodology that 

integrates existing hydraulic model information into GIS-based terrain models. The 
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limitation of the approach is the need for field surveyed cross-sections in order to 

obtain the terrain information. 

Digital terrain information developed from aerial photography is becoming more 

accurate (Figure 1-2), and improvements in image acquisition and interpretation can 

provide the degree of detail required for hydrologic modeling. The research presented 

in this report validates the applicability of these technical improvements in the 

floodplain analysis field. 

 

Figure 1-2. Example of digital terrain representation. 

1.4 Structure of Report 

This report documents the development and implementation of a regional model for 

floodplain determination and representation. The report is divided into six chapters. 

Chapter 2 includes a discussion of the data used for the analysis. The technical 

capabilities of the computer programs used during the research are outlined in 
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Chapter 3, while the application of these data and programs to a study area is 

documented in Chapter 4. Chapter 5 summarizes and discusses the findings of the 

research, and Chapter 6 presents conclusions and recommendations. Appendix A 

includes a tutorial exercise for using AVRas. Appendix B explains the meaning of the 

TINs and how they are generated. Appendix C provides a data dictionary describing 

the digital data used in the project. Appendix D documents the AML and avenue 

scripts developed through the research. Finally, some indications about the process of 

creating animations are given in Appendix E. 
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2 Chapter 2: Data Discussion 

This chapter analyzes the data used in the research. The first section focuses on the 

data requirements, while the last section illustrates the sources and processing of 

these data. The use of the data presented here is described in Chapter 4. 

2.1 Data Requirements 

Information in this study was classified according to its use as hydrologic data, 

hydraulic data, and data required for floodplain determination and visualization; each 

type is explored below individually. 

2.1.1 Hydrologic Data 

Each project employing the HEC-HMS hydrologic model requires three data 

components: a Basin Model, a Precipitation Model, and a Control Specifications. 

The Basin Model contains parameter and connectivity data for hydrologic elements 

such as subbasin, routing reach, sources, sinks and diversions. CRWR-PrePro 

generates this information in ArcView and exported it into HEC-HMS using the 

following data: 

− DEM representing elevation of the terrain. 

− Stream network. 

− Coverages corresponding to the soil types and land uses. 

− Location of gage stations. 

− Stream parameters (flow velocity and Muskingum X). 

The Precipitation Model includes meteorological data and some information required 

to process it. Although the latest version of CRWR-PrePro supports different methods 
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to interpolate and generate precipitation data, the analysis presented here used rainfall 

values corresponding to a 100-year design storm, typed directly into HEC-HMS. 

Lastly, the Control Specifications define time-related information for a simulation, 

including the starting and ending dates and the time interval for computations. 

2.1.2 Hydraulic Data 

The execution of a simulation using the hydraulic model HEC-RAS requires the 

specification of three sets of data: Geometric data, Flow data, and Plan data. 

The Geometry data comprise the description of the terrain related to the stream 

channel, including the stream centerline, riverbanks, floodplain boundaries, terrain 

cross-sections along the streams, and hydraulic structures such as culverts or bridges. 

AVRas extracts most of this information (excluding the hydraulic structures) from a 

digital representation of the terrain provided by the user. The degree of detail required 

from this terrain representation is very high and critical for the accuracy of the 

floodplain map delineation. 

The Flow data include the values of the discharges. These values can be imported 

directly from the HEC-HMS run for different hypothetical design storms. The 

location of stream gages helps identify the discharge values corresponding to a given 

location along the stream. 

Finally, the Plan data specify the flow regime − subcritical, supercritical, or mixed 

flow regime − selected for the simulation. 

2.1.3 Data Required for Floodplain Determination and Visualization 

The determination and visualization of flooded areas in ArcView requires a detailed 

representation of reality to accurately identify the structures and facilities affected by 

the water. 
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Data required for floodplain determinations are the same as those used to extract the 

geometric information provided to HEC-RAS. Digital orthophotographs and data 

coverages (representing buildings, roads, railroads, etc.) also help improve the 

visualization of the flooded areas. 

2.2 Data Sources and Processing 

According to their source, data in this research were classified as geospatial 

information − comprising GIS coverages and the digital terrain model − and non-

spatial information, including precipitation data and user-defined model parameters. 

Each type is analyzed below. 

2.2.1 Geospatial Data 

The City of Austin Watershed Protection Department provided most of the digital 

information used in this study, including the digital orthophotographs and the TINs. 

This information was projected in the State Plane Texas Central zone 5376 system, 

based on datum NAD83, spheroid GRS 1980, and horizontal map units expressed in 

feet. All the data provided in a different system were reprojected to match with the 

described system. Since ArcView only allowed the projection of vector data, 

coverages and grids were projected using the Arc/Info command project that required 

a text file specifying the input and output projection parameters. 

2.2.1.1 DEM 

Thirty-meter resolution DEMs are accessible at the Texas Natural Resource 

Information System (TNRIS) web site. Covering the Waller Creek area required 

several grids corresponding to different quads. These quads were merged and clipped 

using the ArcView extension CRWR-Raster v. 1.0 for analysis of raster data. The 

elevation values were converted from feet into meters using a conversion factor of 

0.3048. The resulting grid was reprojected using the following projection file: 
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input 

projection UTM 

zone 14 

datum NAD83 

units METERS 

spheroid GRS1980 

parameters 

output 

projection STATEPLANE 

zone 5376 

datum NAD83 

units METERS 

spheroid GRS1980 

parameters 

end 

2.2.1.2 Land Use 

The USGS Land Use/Land Cover (LULC) coverages for Waller Creek are available 

at the United States Environment Protection Agency (EPA) web site. Again, 

coverages were merged and clipped using ArcView and reprojected with Arc/Info. 

The projection file used in this case to reproject the coverages from the Albers system 

is shown below: 

input 

projection LAMBERT 

datum NAD83 

units METERS 

spheroid GRS1980 

parameters 

34 55 0.000 

27 25 0.000 

-100 0 0.000 

31 10 0.000 

output 

projection STATEPLANE 

zone 5376 

datum NAD83 
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units METERS 

spheroid GRS1980 

parameters 

end 

The City of Austin has a LULC map for the study area, which could be used in future 

studies. 

2.2.1.3 Soil Type 

Soil data can be downloaded from the State Soil Geographic Database (STATSGO) at 

the United States Environment Protection Agency (EPA) web site projected in the 

State Plane system. Again, coverages were merged and clipped with ArcView and 

reprojected using Arc/Info. The STATSGO grid was reprojected using the following 

projection file: 

input 

projection ALBERS 

datum NAD83 

units METERS 

spheroid CLARKE1866 

parameters 

29 30 00 

45 30 00 

-96 00 00 

23 00 00 

0.0 

0.0 

output 

projection STATEPLANE 

zone 5376 

datum NAD83 

units METERS 

spheroid GRS1980 

parameters 

end 
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2.2.1.4 Stream Gages 

The information corresponding to the stream gages came from the Flood Early 

Warning System (FEWS) of the City of Austin. The FEWS comprises around 92 gage 

stations − five of them within Waller Creek − capable of sending rainfall and stream 

flow information to a data center where it is monitored (Figure 2-1). The coverage 

with the location of the gages was already cast in the State Plane Texas Central zone 

5376 projection system. 

 

Figure 2-1. Gage stream locations 
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2.2.1.5 Terrain Information 

The first step in generating the terrain information is to take aerial images of the area. 

TINs and digital orthophotographs are the result of processing these images using 

specific processing software and instruments as well as some ground control points. 

Both TINs and digital orthophotographs are analyzed below. 

A TIN is an efficient way to represent continuous surfaces as a series of linked 

triangles. TINs are useful for representing surface elevation, subsurface elevation, and 

terrain modeling, especially when the represented surfaces are highly variable and 

contain discontinuities and breaklines. The TIN components are nodes, triangles, and 

edges (Figure 2-2). Nodes are locations defined by x, y, and z values from which a 

TIN is constructed. Triangles are formed by connecting each node with its neighbors 

according to the Delaunay criterion −making triangles as equi-angular as possible. 

Edges are the sides of triangles. Appendix B explains in detail the meaning of TINs 

and how to create them. 

 

Figure 2-2. Triangular Irregular Network 
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Digital orthophotographs result from a process called ortho-rectification, which 

corrects the scale of the aerial photographs and stores the data in a digital support; the 

procedure requires aerial photographs and a TIN digital terrain model as inputs. There 

are two sources of orthoimagery: 

− USGS Digital Ortho Quarter Quads (DOQQs) are 1:12,000 photographs 

covering 1:24,000 map sheets by four images. These are the orthophotographs 

used in this research 

− Other aerial mapping programs, such as those undertaking by CAPCO at 

various scales to generate Digital Orthophoto Quadrangles (DOQs). 

DOQQs are important sources of information, which can be used as GIS base maps, 

allowing realistic representations of the terrain very suitable for 2D visualization 

purposes (Figure 2-3). Furthermore, data coverages corresponding to buildings, roads, 

railroads, etc. (mostly used to improve 3D representations) come from the DOQQs. 

 

Figure 2-3. 2D Floodplain representation of Waller Creek using DOQQs as a 

background image 
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2.2.2 Non-Spatial Data 

2.2.2.1 Precipitation Data 

Precipitation data for hypothetical storms are calculated as a function of the return 

period and the duration of the event. These data are obtained from statistical analyses 

of extreme storm rainfall data recorded at gages, and can be reached at the CRWR 

web site http://www.crwr.utexas.edu/texas/rainfall (Figure 2-4). 

 

Figure 2-4. Texas Rainfall Intensity website. 

The values obtained from this server were precipitation intensities in mm/h; to 

convert these values into depth of precipitation, it was necessary to multiply the 

intensities by the rainfall duration and to convert the new values from mm into 

inches. The results for different 3-hour duration storms appear in Table 2-1. 
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Table 2-1. Design precipitation values for 3-hour duration storms. 

2 yr design 10 yr design 25 yr design 100 yr design 3 hour 
duration mm/h In mm/h in mm/h In mm/h in 

5 min 183.5 0.60 258.7 0.85 299.3 0.98 378.0 1.24  

15 min 116.8 1.15 168.8 1.66 196.2 1.93 246.7 2.43 

60 min 49.4 1.95 73.8 2.91 86.6 3.41 109.4 4.31 

120 min 29.9 2.35 45.4 3.58 53.5 4.21 68.0 5.35 

180 min 22 2.60 33.7 3.98 39.9 4.71 51.0 6.02 

Rainfall depth values corresponding to design storms for the City of Austin are 

illustrated in Table 2-2 (City of Austin, 1977). 

Table 2-2. Rainfall depth (inches ) in 10 minute increments. 

Minutes 10-year 25-year 100-year 

10 0.070 0.105 0.138 

20 0.083 0.122 0.155 

30 0.104 0.140 0.168 

40 0.126 0.167 0.203 

50 0.146 0.173 0.250 

60 0.170 0.225 0.332 

70 0.250 0.306 0.429 

80 0.450 0.510 0.665 

90 1.250 1.417 1.700 

100 0.650 0.783 0.935 

110 0.317 0.417 0.513 
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Table 2-2. Rainfall depth (inches ) in 10 minute increments (continued). 

120 0.203 0.297 0.373 

130 0.164 0.192 0.293 

140 0.142 0.170 0.243 

150 0.112 0.143 0.182 

160 0.093 0.126 0.159 

170 0.073 0.119 0.147 

180 0.067 0.099 0.135 

 

2.2.2.2 User-defined Model Parameters 

User-defined model parameters include the flow velocity, the Muskingum X values, 

and the flow regime. The first two sets of values affect how the hydrologic model 

calculates the water flow within the streams and can be changed to calibrate the 

model. Also, the hydraulic model requires the flow regime − subcritical, critical or 

supercritical − to accomplish the simulations. 

2.2.2.3 Field Survey Data 

The City of Austin Watershed Protection Department provided field data 

corresponding to a series of cross-sections, culverts and bridges, along Waller Creek. 

The data were provided as HEC-RAS geometric files. The identification number of 

each cross-section defined its location, measured in feet, from the end of the stream. 

Since there was no information regarding the orientation of the cross-sections, these 

were assumed perpendicular to the stream centerline. The field survey data were used 

to run the hydraulic model and also to analyze the accuracy of the terrain profiles 

extracted from the TIN. 
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3 Chapter 3: Modeling 

This chapter discusses the modeling capabilities of the computer programs used in the 

research. The analysis focuses on the hydrologic model HEC-HMS, the hydraulic 

model HEC-RAS1, and the GIS-based applications CRWR-PrePro and AVRas. 

Chapter 4 documents the application of the computer models presented in this chapter 

using the data described in Chapter 2. 

3.1 HEC-HMS 

HEC-HMS is a hydrologic model developed by the Hydrologic Engineering Center 

(HEC) of the U.S. Army Corps of Engineers. In 1968, the HEC released the HEC-1 

computer model to aid engineers in hydrologic analysis. HEC-HMS was released in 

1998 as an improved Windows-based version of the HEC-1 hydrologic model. The 

program simulates the surface runoff response of a river basin to precipitation by 

representing the basin as an interconnected system of hydrologic and hydraulic 

components such as subbasins, stream channels and reservoirs. HEC-HMS modeling 

results can be used as input data for hydraulic modeling. 

HEC-HMS provides the following options for simulating precipitation-runoff 

processes: 

− Several alternatives for loss determination. 

− Lumped or linear distributed-runoff transformation methods. 

− Hydrologic routing options. 

                                                

1 The HEC-HMS Hydrologic Modeling System User’s Manual(14) and the HEC-RAS River Analysis 

System User’s Manual(15) provide more information about the topics discussed in this chapter. 
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− A powerful parameter optimization system (HEC, 1999). 

All these capabilities are detailed below. 

3.1.1 Loss Determination 

The term losses refers to the amount of rainfall infiltrated into the soil. HEC-HMS 

supports the most common methods for calculating losses – such as initial/constant, 

SCS Curve No., gridded SCS Curve Nos., and the Green and Ampt –, and provides a 

moisture depletion option for simulations over extended periods of time. These 

methods can be divided into lumped and linear-distributed. In a lumped analysis, 

losses are spatially-averaged over a subbasin, while in a linear-distributed mode, the 

rainfall is specified on a gridded basis, and losses are calculated for each grid cell in a 

subbasin. 

3.1.2 Runoff Transformation 

Runoff transformations convert excess precipitation on a subbasin to direct runoff at 

the subbasin outlet. Again, HEC-HMS allows runoff transformation determinations 

using lumped or linear distributed approaches. In a lumped mode, the amount of 

runoff is determined using unit hydrographs – such as Clark, Snyder or SCS – or 

kinematic wave methods. In a linear-distributed method – like the Modified Clark – 

the subbasins are divided in grid cells, and the rainfall excess from each cell is 

“lagged” to the basin outlet. 

3.1.3 Routing 

Routing techniques handle the movement of the runoff from the different subbasin 

outlets toward the end of the river basin. HEC-HMS’s routing options include the 

Muskingum, the Modified Puls, the Kinematic Wave and the Muskingum-Cunge 

methods. 
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3.1.4 Parameter Optimization 

Once set up, a hydrologic model requires a calibration process accomplished by 

changing some user-defined parameters. The process can be more or less difficult 

depending on some factors, such as the number of parameters or the complexity of 

the network. If required, HEC-HMS provides the possibility to enable automated 

estimation of values for calibrating purposes. 

3.2 HEC-RAS 

HEC-RAS is a hydraulic model created by the HEC in 1990. The program is a 

Windows-based version of the hydraulic model HEC-2 released by the HEC in 1969 

to assist engineers in hydraulic modeling. HEC-RAS is intended for calculating water 

surface profiles for one-dimensional flow and steady gradually varied flow situations. 

The results from the model can be applied in floodplain management and flood 

insurance studies in order to evaluate floodway encroachments (HEC, 1997). 

The program provides the following capabilities: 

− Modeling of full channel networks, dendritic systems, and single rivers. 

− Analysis of bridges, weirs, and culverts. 

− Handling of subcritical, supercritical, and mixed-flow regimes. 

The main features of the program are described below. 

3.2.1 Water Surface Profile Determination 

HEC-RAS allows steady flow water surface profile computations. The iterative 

solution of the energy equation (using the standard step method) solves most of the 

steady flow situations, while Manning’s equation and contraction/expansion 

coefficients determine head losses. Finally, the momentum equation helps analyze 
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mixed flow regime hydraulics of bridges and stream junctions. Future components of 

HEC-RAS will include features for simulating one-dimensional unsteady flow 

through a full network of open channels. The model will also support one-

dimensional analysis of sediment transport/movable boundary, resulting from scour 

and deposition over moderate time periods (HEC, 1998). 

3.2.2 Hydraulic Structures Analysis 

HEC-RAS considers the effect of hydraulic structures such as bridges, culverts, and 

weirs. The analysis is accomplished using the energy equation, the momentum 

equation, and also the WSPRO and Yarnell methods for bridge calculations. 

3.2.3 Parameters Discussion 

HEC-RAS requires a number of input parameters for hydraulic analysis of the stream 

channel geometry and water flow. The parameters used for this research were already 

described in Chapter 2 and include geometric data for streams and reaches definition, 

Manning’s roughness coefficients, channel contraction and expansion coefficients, 

and geometric values for existing hydraulic structures. 

3.3 GIS-based Applications 

Geographic Information Systems are computer environments where users can create, 

manipulate, store, and display graphical elements with associated data. GIS 

applications support engineering analysis in very different fields, including hydrology 

and hydraulics. The GIS-based applications used in this research are CRWR-PrePro 

and AVRas, both working under the ArcView GIS software. 

CRWR-PrePro is an ArcView extension created by the Center for Research in Water 

Resources, at the University of Texas at Austin. The application generates the 

hydrologic elements required by HEC-HMS, including the subbasins, reaches, 



 22 

sources, sinks and diversions. For more information about CRWR-PrePro, the reader 

is referred to Olivera (1999). 

AVRas was created by the ESRI to automate the extraction of spatial components – 

stream network and cross section – from a TIN terrain representation. These 

components are used as input data for HEC-RAS. AVRas also automates floodplain 

delineation based on the HEC-RAS output and the TIN terrain representation. Again, 

more information regarding AVRas can be obtained from the ESRI at the website 

http://www.esri.com/library/userconf/proc99/proceed/papers/pap809/p809.htm. 
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4 Chapter 4: Application Procedure 

This chapter details the application of the modeling procedure to the Waller Creek 

watershed in Austin, Texas. The procedure consists of six steps: 

1. Preprocessing GIS data with CRWR-PrePro. 

2. Hydrologic modeling using HEC-HMS. 

3. AVRas Pre-processing. 

4. Hydraulic modeling with HEC-RAS. 

5. AVRas Post-processing. 

6. Floodplain representation. 

The next subsections describe these steps. Appendices A and B provide specific 

information on the methodology followed to generate the digital terrain representation 

and to accomplish the hydraulic modeling. 

 

Figure 4-1. Floodplain mapping methodology. 
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Figure 4.1 illustrates the use of GIS to obtain the schematic and the parameters 

required by HEC-HMS. The figure also shows how HEC-HMS uses the information 

imported from ArcView, and generates the flow discharge values that HEC-RAS 

needs. GIS is also utilized to extract the geometric data used by HEC-RAS, and to 

represent the flooded areas. HEC-RAS generates water surface profiles from the flow 

discharges and the geometric data. Once exported into GIS, these profiles help define 

the flooded areas. 

4.1 Preprocessing GIS Data with CRWR-PrePro 

CRWR-PrePro was used to process digital spatial data, extract relevant hydrologic 

information, and generate the hydrologic elements required by HEC-HMS. These 

elements included the subbasins, reaches, sources, sinks, and diversions. 

A typical sequence of work with CRWR-PrePro starts with the delineation of 

watersheds and the definition of the stream network. The initial idea was to generate a 

DEM from the TIN to ensure a perfect match between the hydrologic model and the 

digital terrain model. However, the small cell size of the resulting DEM made the 

process very inefficient. Also, the presence of bridges in the TIN has the effect of 

damming up the stream. For these reasons, the study was finally accomplished using 

an existing 30-meter resolution DEM. A stream network, obtained from the same 

DOQQs used to create the TIN, ensured the consistency between the hydrologic 

model and the TIN. 

The determination of the flow direction and flow accumulation grids required two 

steps. The first step was a “burning” process of the stream network into the DEM. 

The second was the “filling” of all the sinks present on the DEM. 

Once the flow direction was determined, it was possible to locate some gages along 

the streams. The purpose of these gages was to serve as flow control points. The next 

steps were the stream segmentation and the watershed outlets calculation. CRWR-
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PrePro allowed the definition of outlets in those points of the streams where the gages 

were located. 

As soon as the watersheds were delineated, both streams and watersheds were 

converted from a raster representation into a vector representation. The results were 

two polyline shape files with the streams and the watersheds (Figure 4-2). 

 

Figure 4-2. Stream network and watersheds at Waller Creek. 

The determination of the losses used the SCS Curve Number method. Meanwhile, the 

runoff transformation was determined using the SCS Unit Hydrograph. Finally, the 

runoff was routed using the Muskingum and Lag Time methods (depending on the 

length of the streams). 
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The SCS Unit hydrograph required the average SCS Curve Number (CN) for the 

watershed. This value was determined as an average of the CN values within each 

sub-basin. CRWR-PrePro calculated a CN grid from the Anderson Land Use Code 

and the STATSGO soils data. The required average CN values were obtained from 

this CN grid. The procedure required a series of tables to spatially relate soil 

characteristics and land use to runoff coefficients used in the SCS Runoff CN method 

(Smith, 1995). 

Up to this point, all the pre-processing of the hydrologic system was finished. The 

next step was the determination of the hydrologic parameters for each element. A 

user-defined parameter table (Figure 4-3) provided those parameters that could not be 

obtained from the spatial data. These parameters were the stream velocity (expressed 

in m/s) and the Muskingum X (dimensionless). 

 

Figure 4-3. Parameter table. 

The velocity of the water along the streams was equal to 1 m/s and the Muskingum X 

was set to 0.15 in every case. Although the calibration of the model was not part of 

this research, it can be done by changing these parameters. An interesting approach is 

to try stream velocity values proportional to the ½ power of the slope of the stream. 

This approach considers the Manning’s equation for flow in open channels; the 
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website http://www.ce.utexas.edu/prof/maidment/grad/azagra/ce394k3/project.htm 

provides more information about this point. 

The last step before running HEC-HMS was to calculate the schematic (Figure 4-4) 

and to generate the Basin File. The Basin File contains the parameter and connectivity 

data for the hydrologic elements. 

 

Figure 4-4. Waller Creek schematic. 

4.2 Hydrologic Modeling using HEC-HMS 

HEC-HMS generates a basin model using the information included in three data sets: 

the Basin File, the Precipitation Model and the Control Specifications. 

The Basin File was created by CRWR-PrePro in ASCII format and was automatically 

loaded into HEC-HMS. Figure 4-5 represents the schematic of Waller Creek with the 
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watershed, the stream map, and an overlay of the hydrologic elements. The 

identification number of HEC-HMS junctions and their corresponding gages in 

CRWR-PrePro was the same. This arrangement made the flows comparison easier. 

By this point, all the geospatial aspects of the model were established.  

 

Figure 4-5. HEC-HMS schematic for Waller Creek. 

The Precipitation Model is the set of information required to define historical or 

hypothetical precipitation data. The Precipitation Model used for this study was a 

100-year design storm of 3 hours duration. The maximum intensity interval 

considered was 5 minutes (Figure 4-6).  
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Figure 4-6. HEC-HMS Precipitation Model for a 100-years hypothetical storm. 

Table 2.2 provides rainfall depth values corresponding to the standard design storm 

for the City of Austin. These values are higher than the ones used in this research (i.e 

7.02 inches of precipitation depth for 3 hours) and would provide bigger flows. 

The last information required by HEC-HMS corresponded to the Control 

Specifications. This information defines the duration of the simulation and also the 

time interval of the calculations. The analysis was accomplished using a 10 minutes 

interval. The duration selected was twelve hours, long enough to depict the runoff 

from a 3-hour storm. 
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Once all the input information was ready, it was possible to run the model. Figure 4-7 

shows the hydrograph corresponding to the outlet of the watershed, which is located 

at the junction with the Colorado River (Junction 2). 

 

Figure 4-7. Hydrograph at the Waller Creek watershed outlet. 

The red line represents the contribution of the small area of Waller Creek 

immediately upstream of the outlet. The black line is the contribution of the rest of 

the watershed (routed by the river). Finally, the blue line corresponds to the total 

hydrograph of the Junction 2. 

HEC-RAS used the flow values calculated by HEC-HMS at different locations along 

the streams and at different times (Table 4-1). The locations corresponded to the 
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outlets defined in CRWR-PrePro. The chosen time interval for reading flows was 

equal to 30 minutes. 

Table 4-1. Calculated flows (cfs) for a 100-year storm at Waller Creek. 

 

The bold numbers in Table 4-1 indicate the substitution in HEC-RAS of the initial 

flow value by the maximum absolute flow registered at the junction, which occurred 

1 2 3 4 5 6 7 8 9
0:00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
1:00 42.20 25.70 2.12 7.25 1.63 19.30 25.80 15.10 9.15
2:00 1804.40 1394.70 113.65 490.19 93.28 1482.00 1184.20 962.90 481.04
3:00 4538.30 4214.30 47.12 275.62 36.86 1085.40 2080.70 2859.20 340.82
4:00 5439.10 5395.70 6.55 54.84 5.12 279.30 602.20 1227.40 89.66
5:00 3907.00 4415.70 0.40 6.32 0.32 43.90 108.50 281.40 15.79
6:00 1724.10 2216.90 0.01 0.36 0.01 5.80 14.80 50.70 2.23
7:00 525.30 748.00 0.00 0.00 0.00 0.30 1.20 7.30 0.12
8:00 125.70 191.80 0.00 0.00 0.00 0.00 0.00 0.50 0.00
9:00 25.30 41.10 0.00 0.00 0.00 0.00 0.00 0.00 0.00

10:00 3.80 6.90 0.00 0.00 0.00 0.00 0.00 0.00 0.00
11:00 0.40 0.80 0.00 0.00 0.00 0.00 0.00 0.00 0.00
12:00 0.00 0.10 0.00 0.00 0.00 0.00 0.00 0.00 0.00

Max. Flow Time 3:50 4:00 2:20 2:20 2:10 2:30 2:50 2:50 2:30

10 11 12 13 14 15 16 17 18
0:00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
1:00 17.40 14.10 14.50 12.20 16.90 17.80 31.00 45.30 55.70
2:00 978.30 588.70 696.20 900.90 1006.50 955.90 1767.60 1790.90 1861.10
3:00 2898.90 1273.90 1413.70 3265.70 3488.70 2068.80 5311.40 5410.30 4701.90
4:00 1679.70 511.70 651.10 2321.00 3077.30 1058.70 4358.00 4846.00 5419.90
5:00 454.20 147.60 191.90 749.50 1395.30 325.60 1905.90 2455.90 3373.60
6:00 87.80 41.10 53.10 161.00 390.30 87.00 546.20 784.90 1328.60
7:00 14.40 11.80 14.90 27.70 81.70 23.20 122.00 187.30 371.80
8:00 1.30 2.30 3.60 3.20 13.60 6.40 23.70 38.20 84.30
9:00 0.00 0.10 0.30 0.20 1.60 0.80 3.10 5.80 15.90

10:00 0.00 0.00 0.00 0.00 0.10 0.00 0.20 0.50 2.10
11:00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.20
12:00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00

Max. Flow Time 3:00 2:40 2:50 3:10 3:30 2:50 3:10 3:20 3:40

Time

Time
Junction

Junction
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within the time interval where the substitution was made. These substitutions ensured 

that the highest flows were used in the hydraulic analysis. 

The discharge values obtained from HEC-HMS can be compared to observed values 

stored in historic records. The flow value calculated for the Junction 17 (close to 15th 

Street) was compared to the maximum discharge recorded at the 23rd Street Stream 

Gage, occurred on October 11, 1973. The maximum discharge measured at that date 

was 4,020 cfs, 25 % lower than the value predicted by the model (5,410 cfs). This 

result could reflect the rapid urban development occurred in Austin since 1973, which 

would increase the imperviousness of the terrain and, therefore, the total runoff. 

Therefore, the modeled values were considered reasonable enough to accomplish the 

hydraulic model and to continue with the analysis of the floodplain mapping 

methodology. 

4.3 AVRas Pre-processing  

The goal of this part of the procedure was to develop the basic spatial data required to 

generate the HEC-RAS Geometry Import File. The process required the completion 

of the following steps: 

− Generation of a digital terrain model. 

− Definition of base 2D spatial features. 

− Generation of 3D spatial data and HEC-RAS Geometry Import File. 

4.3.1 Digital Terrain Model Generation 

AVRas supports different formats of input data for creating TINs. Appendices A and 

B detail the procedure followed to create the TINs from data stored in GENERATE 

input files. However, the GENERATE input files did not provide information to 

embed structures, such as buildings, into the TIN. Buildings had been included as 

“floating entities” which did not affect the geometry of the terrain, and this 
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assumption was not very realistic. In fact, buildings are artificial barriers for the 

water, which affect flooding events. The embedding process was therefore important. 

Digital information available for the buildings included shapefiles with a series of 2D 

polygons representing the footprint of the buildings. The attribute tables associated to 

these shapefiles included a field called Elevation with the height of the buildings. 

The BufferElev script provided in Appendix C was developed to accomplish part of the 

embedding process. The process required the coverage with the 2D polygons 

representing the buildings. The script buffered these polygons horizontally by -0.1 ft 

and raised them until they were transformed into 3D features called PolygonZ. These 

PolygonZ formed the roof of the buildings and had the same shape as the bases but a 

smaller area. These approach avoided the existence on truly vertical faces in the 

building, which cannot be represented in TINs. The Z components for generating each 

PolygonZ were extracted from the Elevation field of the attributes table. The bases of 

the buildings were also PolygonZ features created from the original 2D polygons 

using ArcView functions. This time, each Z component was extracted from the terrain 

surface defined by the TIN. 

Finally, before creating the new TIN with the buildings, it was necessary to delete the 

breaklines and mass points falling within the 2D polygons. Once the process was 

over, the new TIN was created using the remaining mass points and breaklines, and 

also with the two PolygonZ files that defined the bases and roofs of the buildings 

(Figure 4.8). 

Since the data corresponding to the buildings was not complete (not all the building 

had elevation values), the approach was only applied to a small area of Waller Creek. 

The results were stored in an ArcView project called buildings.apr (see Appendix C). 
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Figure 4-8. TIN with buildings embedded. 

4.3.2 2D Spatial Features Definition 

With the digital terrain representation completed, the next step was to extract the 

geometric information required by HEC-RAS. 

This step started with the delineation of a series of 2D spatial features corresponding 

to the stream centerlines, the left and right bank lines, the flow paths, and the cross-

sections along the streams (Figure 4-9). The features – with the only exception of the 

centerlines – were visually identified using a DOQQ and delineated by hand 

following the rules explained in Appendix A. In general, the delineation of cross-

sections located close to river junctions was not easy: each cross-section had to cross 

the stream centerline exactly once, the bank lines exactly twice, the flow paths 

exactly three times, and they could not intersect each other. Complying with these 

rules was not always easy, especially when having two stream centerlines close. 
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Finally, future analyses should be accomplished with these features – at least the 

banks – already stored in shape files obtained from aerial photographs. 

 

Figure 4-9. Centerline, banks, flowpaths and cross-sections delineation. 

Appendix A describes the information stored in the attribute tables associated with 

these features. 

4.3.3 3D Spatial Features and HEC-RAS Geometry Import File Generation 

The 3D spatial data generation involved the creation of 3D stream centerlines and 3D 

cross-sections, with Z values to define elevations. The Z values were extracted from 

the TIN. Once generated, the 3D features identified the stream network and the HEC-

RAS model layout. Again, Appendix A analyzes the information stored in the 

attribute tables corresponding to the 3D features just created. This information was 

saved into the HEC-RAS Geometry Import File. 
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4.4 Hydraulic Modeling with HEC-RAS 

The objective of the hydraulic modeling process was to convert the flow values 

calculated with HEC-HMS into water surface elevations along the stream network. 

Chapter 2 includes a discussion of the different data required for the hydraulic 

modeling: Geometric data, Flow data, and Plan data. 

The Geometry data contained the description of the terrain related to the stream 

channel, including the stream centerline, riverbanks, floodplain boundaries, terrain 

cross-sections along the streams, and hydraulic structures such as culverts or bridges. 

AVRas automated the extraction of spatial components for HEC-RAS input, 

specifically the stream centerline, riverbanks, floodplain boundaries and terrain cross-

sections (Figure 4-10). The location of the banks along the cross-sections extracted 

from the TIN was not very accurate. Therefore, every cross-section was checked 

manually; the banks were relocated when necessary. 
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Figure 4-10. HEC-RAS schematic of Waller Creek. 

The structures such as bridges and culverts could not be extracted from the TIN. 

These structures were manually added to the model through the HEC-RAS interface 

(Figure 4-11). The available field information did not include every bridge or culvert 

along the stream network, and for this analysis just the two bridges located at the 3rd 

and 10th streets were included in the model. Future work should include all the 

structures existing in Waller Creek. 
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Figure 4-11. HEC-RAS bridge definition. 

The discharge values were imported directly from the HEC-HMS run for a 100-year 

return period design storm. The location of stream gages helped identify the discharge 

values corresponding to different locations along the streams (Figure 4-12). 

 

Figure 4-12. HEC-RAS discharge values imported from HEC-HMS. 
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The roughness coefficients (Manning coefficients) and boundary conditions were 

added to the model by hand. The values selected were 0.03 and 0.04, for the stream 

channel and overflow banks, respectively. The boundary conditions are illustrated in 

Figure 4-13. The Normal Depth S defines the slope of the water surface at a given 

location. 

 

Figure 4-13. Boundary conditions defined for the Waller Creek model. 

The model was run for subcritical flow regime conditions and steady flow water 

surface profile computations. The iterative solution of the energy equation, using the 

standard step method, solved the steady flow, while Manning’s equation and 

contraction/expansion coefficients determined head losses. The effect of the bridges 

and culverts was also determined by solving the energy equation. The results of the 

hydraulic model were saved by HEC-RAS in a GIS compatible format called 

Geographic data Export File. 

4.5 AVRas Post-processing 

The AVRas post-processing automated floodplain delineation, based on the HEC-

RAS Geographic Data Export File and on the TIN. 
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The post-processing involved the generation of different themes. These themes 

included cross-section cut lines and bounding polygons for the various profiles 

developed with HEC-RAS (Figure 4-14). Each cross-section contained the stream and 

reach identifiers, the station number, information indicating if the cross-section was 

interpolated by HEC-RAS or not, and the water surface elevation in feet as was 

defined in the RAS GIS Export File. The bounding polygon theme contained 

polygons depicting the bounding polygons of the RAS analyses. Polygons generated 

for different water surface profiles were stored in separate bounding polygon themes. 

Appendix A explains in detail the information associated with these themes. 

 

Figure 4-14. Cross-section and bounding polygons imported from HEC-RAS.  

AVRas created a TIN with the water surface elevations. This TIN was compared  

with the terrain TIN to define flooded areas. In order to perform this comparison, both 

the terrain and the water surface TINs were converted into grids. The cell size for the 

TIN-to-grid conversion was set to 10 meters. A smaller cell size would have provided 
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more accurate results, but AVRas limited the maximum number of cells for the 

resulting grids to preserve the efficiency of the computations. The grids were 

compared, and flooded areas were defined for those cells where the water surface was 

higher than the terrain elevation. The flooded areas were finally converted into the 

polygon theme that formed the final flood plain theme (Figure 4-15). 

 

Figure 4-15. Floodplain map of part of Waller Creek. 

4.6 Floodplain Representation 

The last part of the analysis focused on the floodplain representation capabilities 

provided by GIS. 

First, the floodplain areas were represented using the TIN of the terrain as 

background. The depth of the water at any point of the flooded areas was obtained by 

clicking with the mouse at the desired locations. As explained in Chapter 2, DOQQs 
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were used as GIS base maps and allowed realistic representations of the landscape 

(Figure 4-16). 

 

Figure 4-16. Detention pond at Central Park (Austin, TX). 

The three-dimensional floodplain views were very useful for visualization purposes. 

The inclusion of data coverages corresponding to buildings, roads, railroads, etc., 

improved these 3D representations (Figure 4-17). 
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Figure 4-17. 3D Floodplain Representation of the UT Campus (Austin, TX). 

Finally, some of the 2D and 3D representations generated for Waller Creek were 

converted into 2D and 3D animations. These animations were created from 

successive snapshots corresponding to flood maps determined for different flows. 

Appendix E provides some indications about the process of creating animations. 
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5 Chapter 5: Results and Discussion 

This chapter discusses the results of the research. The analysis focuses on the 

accuracy of the TIN, and compares geometric data extracted from a digital 

representation of the terrain with field survey data. 

5.1 TIN Accuracy 

5.1.1 Terrain Profiles 

One of the goals of this research is to validate the terrain information extracted from 

the TIN. This validation can be accomplished with a comparison between the cross-

sections obtained from the TIN and those obtained from a terrain survey (Figures 5-1 

and 5-2). 

Figure 5-1. Cross-section comparison, station CS 9658 (CAPCO). 
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Figure 5-2. Cross-section comparison, station CS 10117 (CAPCO). 

The general shapes of both profiles were similar. In most of the cases, there was a 

horizontal offset between the two data sets, which could indicate differences between 

the stream centerline obtained from the field, and the one extracted from the DOQQs. 

This offset has been corrected in the profiles included here. 

Figure 5-1 shows how the profile extracted from the TIN provides higher elevations 

than the one generated with field data. These disparities could be explained by 

differences on the location of the two cross-sections. The cross-section extracted from 

the TIN could be placed a little bit upstream with respect to the one defined from the 

field data. The bigger differences for the points located at the bottom of the channel 

(Figure 5-1) could be explained by the existence of some water the day the aerial 

picture was taken. If this were the case, the TIN would be providing elevations 

corresponding to the surface of the water, and not to the bottom of the channel. 

Finally, the differences shown in Figure 5-2 were not easy to explain. They could be 
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justified using the same arguments stated before, or could just be the consequence of 

a not very accurate TIN. 

In any case, this research assumed that both the field surveyed data and the TIN data 

were using the same vertical datum. The TIN was using the NAVD88 vertical datum. 

Since the source of the data was the same in both cases (CAPCO), it was also 

assumed that the field surveyed data used this datum. However, it would be important 

to ensure that these field surveyed data were not using the NGVD29 vertical datum. 

5.1.2 Bridges and Culverts Definition 

The definition of cross-sections was accomplished manually. HEC-RAS required 

cross-sections placed along the stream to define the geometry of the channel, and also 

cross-sections just before and after every bridge and/or culvert along the stream, so 

they could be properly defined. 

The faces of the bridge - the ones perpendicular to the channel - should be 

represented as nearly2 vertical faults, so the cross-sections could be traced as close as 

possible to the bridges. The accuracy of the TIN did not allow these almost-vertical 

faces (Figure 5-3). Instead, a smooth slope was defined upstream and downstream the 

bridges. 

                                                

2 Since functional surfaces are capable of storing only one z value for a given x, y location. 
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Figure 5-3. Bridge definition in a TIN. 

5.2 Banks and Centerline Location 

AVRas extracts most of the geometric information automatically from the TIN. 

However, the lack of digital information for the banks and floodplain, forced a visual 

interpretation of these features that had to be manually delineated. This process 

induced some errors such as the wrong location of the banks along the cross-sections 

(red points in Figure 5-4). These locations had to be corrected one by one. 
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Figure 5-4. Cross-section with banks wrongly located. 

Correct location Correct location 
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6 Chapter 6: Conclusions and Recommendations 

This document presents a methodology for automated floodplain mapping that 

reduces the dependence on field data. The approach links the hydrologic model HEC-

HMS, the hydraulic model HEC-RAS, and the GIS ArcView. The procedure involves 

data extraction from GIS, flow data generation using HEC-HMS, terrain modeling 

with GIS, surface water determination by means of HEC-RAS, and floodplain 

mapping in GIS. This chapter discusses advantages and limitations of the approach, 

potential applications, and suggestions for future research. 

6.1 Advantages 

The computer automation of floodplain mapping results in several benefits: 

− Time and resource savings. The automated floodplain mapping approach 

saves time and resources. The extraction of geometric data from a digital 

terrain representation saves a considerable amount of fieldwork that requires 

large financial and time investment. Furthermore, the procedure allows a 

quick generation of floodplain maps that are typically drawn by hand. This 

task could easily become tedious if the goal is to evaluate different flow 

scenarios. 

− More accurate and standardized results. Automated floodplain mapping 

processes also bring more efficient and standardized results. Some human 

tasks – like the floodplain mapping process – produce subjective results. On 

the contrary, computer based tasks are always accomplished following the 

same pattern. Using computers to complete repetitive tasks provides more 

standardized and easy-to-compare results. The use of a digital terrain 

representation can also decrease errors associated with an incorrect visual 

identification of topographic anomalies. 
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− Digital output. Rendering the floodplain results in a digital format allows the 

use of other digital data (i.e. DOQQs) to help identify structures/facilities of 

interest. Furthermore, this digital output allows an easy comparison of the 

flooded areas with the results of other studies also stored in digital format. 

− Improved floodplain representations. When represented on a digital terrain 

model within a GIS environment, floodplain maps allow the development of 

two and three dimensional representations and animations for visualization 

purposes. Two dimensional representations are useful to determine the depth 

of the water at any given location just by clicking the mouse button. Three 

dimensional animations allow very realistic representations of the flooding 

events. 

6.2 Limitations 

The main limitations discovered during the course of this research were the 

insufficient accuracy of the digital terrain representation used and the dependence on 

field data. The following paragraphs detail these two limitations. 

− Accuracy of the digital terrain representation. Chapter 5 shows how the 

quality of the TIN determines the accuracy of the geometric information used 

in HEC-RAS. This accuracy is crucial to obtain reliable results; differences of 

one foot in the water elevation have a big impact in the extension of the 

floodplain, especially when studying flat areas.�

− Dependence on field data. The proposed methodology is still dependent on 

field data for two reasons. On one hand, the analysis of aerial photographs for 

generating DOQQs and/or TINs requires information of a series of points that 

have to be determined through field surveying. On the other hand, the 

information required for defining hydraulic structures such as bridges and 
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culverts cannot be extracted from the TIN. Again, this information has to be 

obtained through field surveying.�

6.3 Applications 

The methodology described in this paper offers several practical applications; some 

derived from the fact of using an automated floodplain modeling process, and some 

associated with the resulting floodplain maps. The following are some of these 

applications. 

− Design of control structures. Floodplain modeling can be used to determine 

the suitability of building flood control structures for prevention purposes (i.e. 

detention ponds or culverts). The results of modeling a given area with and 

without a particular structure can help make a decision about the 

appropriateness of building this structure. In addition, an important design 

component of bridges, culverts, etc., involves hydraulic analysis to determine 

conveyance capacity (Tate, 1998). Again, the results of the model can provide 

information concerning the extent and depth at locations of interest. 

− Flood insurance rate determination. Flood insurance rates are calculated based 

on floodplain maps. The accuracy of these maps directly affects the price paid 

for flood insurance, especially for those structures located within Special 

Flood Hazard Areas (FEMA, 1998). 

− Real-time flood emergency mapping. The use of real-time precipitation data 

during an intense storm (i.e. NEXRAD data) can help build a real-time flood 

emergency mapping system. These precipitation data can be used to select an 

appropriate floodplain map, previously calculated for flow values 

corresponding to a similar storm and stored in a database. 
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6.4 Recommendations for Future Work 

The following paragraphs share a series of concepts noted during the course of this 

research, which should be considered for future work. 

− Future models should use more accurate TIN representations of the terrain. 

These new TINs must be obtained using new technologies such as LIDAR 

(LIght Detection And Ranging), which are improving the quality of the digital 

terrain representations. Figures 6.1 and 6.2 illustrate some of the highly 

accurate TINs provided by these new techniques. 

 

 
 Source: generated by ASI and published by ESRI. 

Figure 6-1. Digital terrain representation of Manhattan, New York. 
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Source: generated by ASI and published by ESRI. 

Figure 6-2. 3-D polygons on a TIN representation of Manhattan, New York. 

− The availability of data coverages with information about the channel 

centerline and banks would also improve the results. These coverages would 

avoid the manual delineation of banks and centerlines and would save the time 

required for corrections. These data can be acquired from aerial photography 

using the same techniques applied to generate the transportation and building 

coverages used in this research. 

− Finally, digital Q3 flood data could be used to validate the floodplain mapping 

methodology presented in this paper. Digital Q3 flood data are developed by 

the Federal Emergency Management Agency (FEMA) from Federal Insurance 

Rate Maps (FIRM), and are available over the Internet (FEMA, 1999). The 

approach would involve a floodplain modeling process using the same flow 

values utilized by FEMA to generate the Q3 data we would like to validate. 

The resulting floodplain maps would then be compared to those generated by 

FEMA for the same area. 
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1 Appendix A: Introduction to AVRas 

Prepared by 
Esteban Azagra 

Center for Research in Water Resources 
September 1999 

Table of Contents 
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AVRas Pre-processing 

 Preparation of Base ArcView Themes 

 Generation of Additional Attributes and 3D Spatial Data 

 Generation of the HEC-RAS Import File 

Working with HEC-RAS 

AVRas Post-processing 

Floodplain Representation 

Cleaning Up 

Goals of the Exercise 

This exercise is intended to introduce you to computer floodplain analyses and 

representation using the ArcView GIS extension AVRas and the HEC-River Analysis 

System (HEC-RAS). The exercise covers the following concepts: 

• Defining and extracting geometric data from a triangular irregular network (TIN). 

• Using HEC-RAS to perform hydraulic computations to generate water surface 

profiles and floodway boundaries. 



 55 

• Exporting HEC-RAS modeling results into ArcView to create and represent 

floodplain maps. 

The area selected for this example is a part of the Waller Creek watershed in Austin, 

Texas. The exercise focuses on AVRas. If you need to get more familiar with HEC-

RAS you can have a look at the exercise Introduction to HEC-RAS, prepared by Eric 

Tate and David Maidment. 

Software and Data Requirements 

The AVRas 1.2 HEC-RAS Interface extension was created by the Environmental 

Systems Research Institute (ESRI) and is provided for this exercise. You need to have 

ArcView version 3.0 or later running with the 3D Analyst extension to support 

surface modeling and 3D visualization. 

The HEC-RAS program can be obtained from the Hydrologic Engineering Center’s 

home page at http://www.wrc-hec.usace.army.mil/. A user’s manual is also available 

at this location. The program runs on Windows 95/98, NT and Unix platforms. This 

exercise requires that you have HEC-RAS version 2.1 running. 

The data files used in the exercise consist of ArcView shapefiles, AVRas extension 

files, and “GENERATE” files for the digital terrain model. The following files are 

stored in http://www.ce.utexas.edu/prof/maidment/grad/azagra/Research/AVRas/Data/avras.zip: 

• avras.avx − corresponds to the AVRas extension and should be located in the 

esri/av_gis30/arcview/ext32/ folder of your computer. 

• avras.cnt, avras.gid, avras.hlp − help files for AVRas. They must be in the 

esri/av_gis30/arcview/help/ folder. 

• bank.dbf, bank.shp, bank.shx − shapefile of bank locations. 
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• build.dbf, build.sbn, build.sbx, build.shp, build.shx − shapefile for the 

buildings. 

• cross.dbf, cross.shp, cross.shx − shapefile of cross-sections. 

• flow.dbf, flow.sbn, flow.sbx, flow.shp, flow.shx − shapefile of flow boundaries. 

• hardl.lin, massp.pnt, softl.lin − GENERATE files used to create the TIN. 

• terrain.avl − theme color schemes. 

• transport.dbf, transport.sbn, transport.sbx, transport.shp, transport.shx − 

shapefile for the roads and streets. 

Select a working directory on your computer and download these files into it (except 

those corresponding to the AVRas extension). 

Starting ArcView 

Before you go on, you need to set the working directory. From Project menu, choose 

Properties. Type the name of your working directory (where you downloaded/copied 

the files) in the Project Properties… dialog box and click OK . You can create a 

temp folder under your working directory. Save the Untitled Project as avras.apr in 

the working directory. 

Select the File/Extensions… menu option and check the 3D Analyst and AVRas 1.2 

HEC-RAS Interface extensions from the Extensions window. Click OK  and the 

extensions will be loaded. 
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Creating a TIN 

AVRas extracts terrain information stored in TINs and generates a geometry file that 

can be read by HEC-RAS. TINs can be created from points, polygons, and lines 

stored in different formats. In this exercise we will use GENERATE input files 

−ASCII files containing x, y coordinates and z values for point or breakline features− 

to create our TIN. 

Double-click on the Views icon in the Project window to open a new view. You can 

change the name of the view if you want and call it “Input Data”. 

With the new view active, import the data stored in the GENERATE files using 

File/Import Data Source... and choosing the 3D Generate File from the menu. 

Notice that ArcView allows you to import data stored in different formats. Click OK 

to confirm your selection. 

 

Choose Points as the type of input generate file you are importing and click OK. 

Select the file massp.pnt from your working directory and click OK again. From the 

new window, type massp.shp as the name of the output shapefile. You can click OK 

one more time to start importing the file. Select Yes to add the shapefile generated to 

the View. 
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Repeat these steps two more times to import the information corresponding to the soft 

and hard breaklines. Select Lines as the type of input generate file. Choose the 

softl.lin and hardl.lin files when asked for the name of these files and name the 

shapefiles created softl.shp and hardl.shp respectively. You should be able to see 

something similar to this: 
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The next step is the generation of the TIN. Select the three themes you just created, 

go to Surface menu and the click on Create TIN from Features.... The Create new 

TIN window will appear and you will have to specify the following fields for each 

active theme: 

 

• The Class field specifies which type of feature is stored in the shapefile. This 

information is read from the shapefile and you do not have to type any value here. 

The value PointZ will appear if you select the Massp.shp file. For the other two 

files −Shoftl.shp and Hardl.shp− the value will be PolyLineZ. 

• The Height source field specifies what field is used to provide height values for 

the theme. The value <none> can be used for representing features like area 

boundaries. In this case, the value Shape is automatically prompted for the three 

files. PointZ and PolyLineZ are 3D features and their height can be determined 

from their shape. 

• The Input as field specifies what surface feature type the theme will be added as. 

Check that the value selected for Massp.shp is Mass Points, and the ones 

corresponding to Softl.shp and Hardl.shp are Soft Breaklines and Hard 

Breaklines respectively. 
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• The Value field specifies what field −if any− is used to provide values for nodes 

or triangles. If the output type is mass point, the values will be assigned to nodes. 

If the output type is polygonal, the values will be assigned to triangles. Values are 

stored with the TIN data model and can be used later for display, query, and 

modeling purposes. For this exercise we will not assign any value to the TIN. 

Click OK and type “wallertin” when asked for the TIN name. After some 

calculations, the TIN theme will be added to your view. Click the check box to 

display it. The default color scheme is not ideal for observing the TIN. Double click 

on the TIN’s legend bar to open the TIN legend editor. First click off the check box 

next to Lines and then click the Edit button in the Faces part of the window to open 

the regular legend editor. Click on the Load button and choose terrain.avl from your 

working directory. Click OK twice in the Load Legend windows and Apply in the 

legend editor. Your TIN should look like this: 
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We no longer need the themes massp.shp, softl.shp and hardl.shp, so you may 

delete them from the window. It would be a good idea to save your project at this 

point of the exercise. 

AVRas Pre-processing 

The goal of this part of the exercise is to develop the basic spatial data required to 

generate the HEC-RAS Geometry Import File with the 3D stream network and the 3D 

cross section definition. The process is divided in three steps: 

1. Preparation of ArcView themes defining the stream centerline, cross-sections, 

stream banks and flow path lines. 

2. Use of AVRas functions to develop additional attributes required by HEC-RAS 

and to generate 3D spatial data. 

3. Generation of the HEC-RAS Import File. 

Preparation of Base ArcView Themes 

The shapefiles required for the definition of the stream centerline, cross-sections, 

stream banks, and flow path lines are provided for this exercise. However, it is 

important to show you how to create these files. Remember that you DO NOT have 

to do this part to complete this exercise. 

First you will need a Digital Ortho Quarter Quad (DOQQ) or another type of visual 

data source to identify the centerline, banks, and flow paths. You will have to create a 

new theme for each of the required data sets. For each one, with the view window 

active, select New Theme... from the View menu. Choose a Line type theme and 

click OK. After choosing a name for your new theme, you can start delineating by 

clicking the  button. Select Theme/Stop Editing as soon as you finish digitizing 
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and click Yes to save the file. There are some important rules that you have to follow 

during the digitizing process to ensure the correct operation of the AVRas functions: 

• All the lines must be snapped at common nodes and each individual polyline 

should consist of only one part. Use the snapping capabilities of ArcView to 

ensure this continuity. 

• Stream segments and cross-sections have to be identified following certain rules. 

The attribute tables corresponding to each of the shapefiles have to follow the 

same format as the ones included in this exercise. 

• Stream centerlines, flow paths and bank lines have to be pointing downstream and 

cannot intersect. 

• Cross-sections must be digitized from the left bank to the right bank (facing 

downstream). Each cross-section must cross the stream centerline exactly once, 

the bank lines exactly twice, and the flow paths exactly three times. They cannot 

intersect each other. They can be entered without a specific order; only the 

location of the cross-sections is important. 

We are going to carry on with the exercise at this point. Lets start loading the 

shapefiles corresponding to the centerline, flowpaths, banks, and cross-sections. 

With the view window active, select Add Theme... from the View menu. Choose 

centerline.shp from your working directory and click OK. If you click off the check 

box of the TIN your view should look like this: 
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The centerline theme contains the lines defining the stream network that will be 

reconstructed as the river schematic within RAS. As we already indicated, the stream 

centerlines have to be oriented towards the downstream direction and snapped at 

nodes. Click the  button to see what the Attributes table of Centerline.shp looks 

like. 
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• The Stream_id and Reach_id fields are character fields included to identify the 

streams and reaches names. These values were entered manually for each shape in 

the theme when it was created. Notice that one stream is made of one or more 

reaches. 

• The is_Outlet numeric field helps identify if the end of a given reach is an outlet 

or not: “0” means that there is no outlet and “1” indicates an outlet at the end of 

the reach. Again, the values were typed manually for each shape in the theme. 

Close the table and repeat the previous process to open the banks.shp theme from 

your working directory. If you click off the centerline your view must be like this: 

 

The banks theme contains lines depicting the two banks of the main stream. The 

location of the banks along each cross-section will be calculated and stored in the 

cross-section attribute table. The bank lines do not have any significant orientation or 

specific attributes in the attributes table. 
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Open the shapefiles Flow.shp and Cross.shp following the same procedure. If you 

click on these new themes and click off the banks theme your view will be like this: 

 

Notice that you have three flow paths for each reach. These lines are used to calculate 

the reach lengths. Once more, the lines have to be oriented towards downstream 

direction and lines representing the same flow path should be snapped at common 

nodes. Click the  button with the Flow.shp theme selected to see its Attributes 

table. 
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• The Linetype character field is used to define the location of the lines compared 

to the centerline: “L” corresponds to the left overbank; “M” refers to the main 

stream (coincident with the stream centerline); and “R” identifies the right 

overbank. These values were entered manually. 

The cross-sections theme contains the lines defining the cross-sections required by 

HEC-RAS. As in the case of the bank lines, the attributes table does not require the 

introduction of any particular value (we will derive some using AVRas). 

Generation of Additional Attributes and 3D Spatial Data 

In this part of the exercise we will make use of the base data we created to develop 

additional attributes required by HEC-RAS and to generate 3D features with z values 

to define elevations. 

Lets start with the generation of the additional attributes. Select Theme Setup… from 

the AV->Ras menu and fill in the window as shown in the graphic. Click OK  to 

confirm the values. 
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Select Centerline Topology from the AV->Ras menu. You should see a message 

indicating that the process was completed successfully. Click OK to close the 

window. You can compute the stream and reaches distances using the function 

Length/Station Comp. in the AVRas_Util menu. Click OK to close the message 

(indicating the success of the calculations) and click the  button with the 

Centerline.shp theme selected to see its new Attributes table. It should look like 

this: 



 68 

 

You can see the new fields added to the table: 

• The From_st and To_st numeric fields indicate the name of the station up and 

downstream within a reach. The name matches the cumulative distance from the 

origin of the corresponding stream. 

• The From_node and To_node numeric fields show the unique ID for the 

upstream and downstream node of the reach. 

• The Arc_Length numeric field indicates the length of each reach in theme units 

(in this case feet). 

Close the table and select Centerline Z Extract from the AV->Ras menu. Type 

“Centerline3D.shp” when asked for the theme name and click OK to confirm. Click 

OK to close the message confirming that the process was completed successfully. A 

3D shape file has been added to the view. 

The next step is the addition of new attributes to the cross-sections shapefile. Select 

Basic CS Attributing from the AV->Ras menu. A message will indicate that each 

cross-section now has a Stream_ID and a Reach_ID assigned. Click OK to close the 

window and select Station CS Attributing from the AV->Ras menu. Again, a 

message will indicate that each cross-section now has a station number assigned. 

Click OK one more time to close the window.  To compute the cross-section bank 
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percentages (% distance of total cross-section length) you have to select Bank CS 

Attributing from the AV->Ras menu. Close the window by clicking OK. We are 

almost done with the calculation of attributes. We just need to determine the 

downstream cross-section distance along the main channel, left, and right flow paths. 

Select Distance CS Attributing from the AV->Ras menu and click OK to close the 

window (with the message indicating the end of the computation). The final attribute 

table for the cross-section looks like this: 

 

The identification and meaning of the new fields is straightforward. 

Close the table and select AV->Ras/CS Z Extract. Type “Cross3D.shp” when asked 

for the name of the theme and click OK to confirm. Click OK to close the message 

confirming that the process was completed successfully. A new 3D shape file has 

been added to the view. This is probably a good moment to save your work. 

Generation of the HEC-RAS Import File 

The Generation of the HEC-RAS Import File is the last step of the AVRAs Pre-

processing. The idea is to create a HEC-RAS input file in RAS GIS Import format 

with the terrain elevation extracted from the TIN and included in the 3D stream 

centerline and 3D cross-sections themes as z values. 

Click the  button and ignore the warning message by clicking OK. Select 

ENGLISH units when asked and click OK to confirm your selection. Once the 
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generation of the RAS GIS Input file header is completed, you can click OK again 

and wait for the processing of the information regarding the centerline. Click OK to 

start processing the cross-sections information and click OK one more time at the end 

of the process. Save your project and close ArcView. You can use Windows Explorer 

to check that a file called waller.geo has been created in your working directory.  

Working with HEC-RAS�

The first time you start HEC-RAS you will see the main project window, which looks 

like this: 

 

Go to File/New Project to define a new project. Select your working directory and 

then type the title “Introduction to AVRas” and the file name for the project 

“Waller.prj”. Click OK and a window will open confirming the information you just 

entered. Click OK one more time and check that the Project line in the main project 

window is now filled with information. 
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We can keep on going and import the geometric data stored in RAS GIS Import 

format that we created with AVRas. Select Edit/Geometric Data… from the main 

project window and File/Import Geometry Data/GIS Format… from the 

Geometric Data window. Choose the file waller.geo from your AVRas working 

directory and click OK . The resulting view shows the schematic of Waller Creek. 
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You can edit this geometric data if you want. The tick marks and corresponding 

numbers denote cross-sections. You can edit these cross-sections and plot their 

profiles. Notice that special cross-section types, such as bridges or culverts, need to 

be manually entered. 

We are going to set the values for the Manning coefficients. Select 

Tables/Manning’s n or k values from the Geometric Data window. The Edit 

Manning’s n or k Values window will appear. First choose the value (All Rivers)  in 

the River drop box. Click on the n#1 box to select the entire column and click the Set 

Values button. Type a value of “0.04” and click OK. Repeat this process for the n#2 

column entering a value of “0.03” for n, and also for the n#3 column choosing a value 

of “0.04”. The window should look like this: 

 

Click OK to confirm the values. Select File/Save Geometry Data and then File/Exit 

Geometry Data Editor. You will be back to the main project window, which will 

have some new information in the Geometry line. 
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The next step is the definition of the Flow Data. For this project we will assume 

some hypothetical flow values, and do not represent any expected event (although 

they are close to a 100-year storm). 

Select Edit/Steady Flow Data… to start introducing flow values and fill the PF1 

column as shown below. 

 

Click on the Reach Boundary Conditions button. The new window is used to set the 

water surface elevation boundary conditions. We will use the normal depth option.  

Click in the last cell of the Downstream column an then click on the Normal Depth 

button. Set the energy slope at the boundary to “0.001” and click OK to confirm this 

value. 
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Click OK again to leave this window. Apply these flow data with the Apply Data 

button and save the information in your working directory selecting File/Save Flow 

Data. You can type a title for the data, the file name Waller.f* is given. Select 

File/Exit Flow Data Editor to return to the main project window. Notice the 

information added to the Flow line. 

Now that the geometry and flow data have been set we can execute the model. Select 

Simulate/Steady Flow Analysis… from the project window and define a new plan 

−to specify the files to be used in the simulation− with File/New Plan. You will be 

subsequently asked to provide a plan title (i.e. Hypothetical flow conditions) and a 

12 character short identifier. Click OK  twice to confirm your selections. 

 

Ensure that the Flow Regime radio button is set to Subcritical and click the 

COMPUTE  button. This starts a FORTRAN program called SNET, which carries 

out all the calculations. A DOS window with a message indicating the end of the 

process will appear when the computations are completed. Close the DOS window by 

clicking the X in the upper right corner. Select File/Exit  to return to the main window 

and start exporting the results of the analysis into GIS. 
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Before exporting the results, you may want to have a look at the water profiles, cross-

sections and perspective plots like the one shown below. 

 

To export the data select File/Export GIS Data… from the main window. Select the 

export file name as “waller.gis” and be sure you that you save it in your working 

directory (or somewhere else where you can find it). Click OK to confirm the file 

name and click the Export Data button on the new window. The process is 

completed. You can now close HEC-RAS saving your changes. 
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AVRas Post-processing 

With the water surface elevations calculated and exported by HEC-RAS we can 

continue with last part of the exercise. All themes developed during the post-

processing are based on the content of the RAS GIS output file and the TIN. AVRas 

will create a TIN with the water surface elevations and will compare this TIN with 

the terrain TIN to define the flooded areas. Finally, the flooded areas will be 

converted into a polygon theme and form the resulting flood plain theme.  

Start ArcView and open the avras.apr project you saved at the end of the pre-

processing phase. Select Theme Setup… from the Ras->AV menu and fill the 

window as shown below: 

 

Click OK  twice to confirm your selections and to dismiss the window. 

Select CS/BP Generation from the Ras->AV menu to generate a 2D cross-section 

theme and a bounding polygon theme, based on the RAS GIS Export File you just 

created. A window will tell you that the process has been completed. Close it by 
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clicking OK. A new view has been created with the name you selected for the output 

directory and three themes in it. It should be similar to this: 

 

Click the  button with the OutputCS.shp theme selected to see its Attributes 

table. It should look like this one:  
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Each cross-section now contains the stream and reach identifiers, station number, a 

field indicating if the corresponding cross-section was interpolated by HEC-RAS or 

not, and fields (in this case just one) specifying the water surface elevation in feet as 

was defined in the RAS GIS Export File. 

The Bppf_1.shp bounding polygon theme contains polygons depicting the bounding 

polygons of the RAS analyses. Polygons generated for different water surface profiles 

would be stored in a separate bounding polygon themes. 

Select WS TIN Generation from the Ras->AV menu to create a TIN representing 

the water surface elevations. Click OK to close the information window. A new 

theme for the water surface TIN should be in your view. 

We are almost done. AVRas is now going to compare the water elevation with the 

terrain to define the flooded areas, and will convert these areas into a polygon theme. 

Select Floodplain Delineation from the Ras->AV menu. Close the information 

window by clicking OK and change the legend of the Fppf_1.shp theme to make it 

look like water. You should be able to see something like this: 
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Floodplain Representation 

Lets do a final effort to improve the floodplain representation. First, we have to get 

rid of the two “islands” of water formed close to the junction with the main stream. 

Select Theme/Start Editing with the Fppf_1.shp theme selected to start editing the 

theme. Click the  buttton and select the two polygons you want to delete. Select 

Edit/Delete Features and stop editing by selecting Theme/Stop Editing. Confirm 

your changes. 

Finnaly, click the  button to add the buildings.shp and transport.shp themes. 

We can use these two themes as a background to identify which facilities are affected 

by the water. The result should look like this: 
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You can try and use the 3D Analyst capabilities to create a 3D Scene of the flooded 

area. You can play with the height of the buildings and use your imagination to create 

something like this! 
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Cleaning Up 

Welcome to the end of what I hope gave you more of an insight of how ArcView and 

HEC-RAS can work together to produce floodplain maps. Remember that the key 

point for accurate results is to have a detailed terrain model. Go ahead and close 

ArcView, saving your project. 
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7 Appendix B: How to create a TIN from a GENERATE file 

Prepared by Esteban Azagra 
Center for Research in Water Resources 

June 1999 
 

Background 

A triangulated irregular network data model (TIN) is an efficient way for representing 

continuous surfaces as a series of linked triangles. Although both grids and TINs can 

be used for surface representation, TINs are especially useful for representing surface 

elevation, subsurface elevation and terrain modeling, especially when the represented 

surfaces are highly variable and contain discontinuities and breaklines. 

TINs components are nodes, triangles and edges. Nodes are locations defined by x, y 

and z values from which a TIN is constructed. Triangles are formed by connecting 

each node with its neighbors according to the Delaunay criterion: all sample points 

are connected with their two nearest neighbors to form triangles (by using this 

method the triangles are as equi-angular as possible, any point on the surface is as 

close as possible to a node, and the triangulation results are independent of the order 

the points are processed). Edges are the sides of triangles. 

TINs are generated from points, polygons and lines. Points used in defining the TIN 

are called mass points. Areas of constant elevation, such as water surfaces are called 

exclusion polygons. Finally, lines such as streams and shorelines are called 

breaklines. Breaklines can be either hard or soft. Hard breaklines are features like 

roads, streams, and shorelines, which indicate a significant break in slope. Soft 

breaklines are features things like ridgelines on rolling hills. 

Ridges like these do not represent distinct breaks in slope but since they separate 

watersheds you might like to maintain in the triangulation. When a TIN is created, 
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mass points become nodes of triangles, while breaklines and exclusion polygon 

boundaries become triangle edges. 

Data Sources 

Points, polygons and lines can be stored in different formats suitable for creating 

TINs. Multiple input sources include (1) point, line and polygon coverages; (2) points 

and breaklines in (x, y, z) GENERATE input files; and (3) breaklines with z values 

interpolated from a lattice. These data can be obtained with different techniques such 

as DOQQs, field surveys, or LIght Detection And Ranging (LIDAR). This paper 

focuses on the generation of TINs from GENERATE input files. 

A GENERATE input file is an ASCII operating system file containing x, y 

coordinates and z values for point or line features. It can be created with the ArcInfo 

command GENERATE. 

Each GENERATE input file must contain a single class of features, either POINT 

−the file contains points− or LINE −the file contains lines, polygons, or both−. 

Following tables show how both types of GENERATE files look like. 

• GENERATE file with point features: 
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• GENERATE file with line features.  

  

A numeric item in the file specifies how each feature defined will contribute to the 

TIN. Normally, the codes used are those defined by default when the file is created 

with ArcInfo. However, as you will see later, different codes can be defined. The 

default feature type codes are shown below: 

IGNORE 0 

MASS  1 

SOFTLINE 2 

HARDLINE 3 

SOFTREPLACE 4 

HARDREPLACE 5 

SOFTCLIP 6 
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HARDCLIP 7 

SOFTERASE 8 

HARDERASE 9 

BARRIER 10 

Procedure 

The following procedures explain how to create a TIN using Arc/Info or ArcView. 

ArcInfo 

Follow the instructions shown below: 

Arc: w <working space where the GENERATE files are located> 

Arc: createtin <desired TIN name> 

Createtin: generate <name of the file with the points> point 

Createtin: generate <name of the file with the breaklines> lines 

Createtin: end 

This example assumes that each feature contributes to the tin according to the feature 

type information established by default. In case different surface feature type codes 

were used, the user can specify the source of the surface feature type information 

using the {sftype_item | sftype} argument of the GENERATE subcommand. 

Note that the CREATETIN command used here is a versatile tool that creates a tin 

surface model from multiple input sources including Arc/Info coverages, ASCII files 

containing x, y, z coordinates, and breaklines interpolated from a lattice. It also 

allows you to introduce tolerance values to eliminate duplicate points, as well as 

factors to change the elevation units when the tin is generated. More information can 

be found in the on-line help provided by Arc/Info.  
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In case you have to create multiple TINs, you can download the AML code from 

http://www.ce.utexas.edu/prof/maidment/grad/azagra/research/tin.aml. The code is 

also included in Appendix D. 

The code generates each tin from a couple of files, one corresponding to the points 

and the other with the breaklines information. For each TIN, the points file must be 

called *p.atn while the lines file has to be called *l.atn (for instance, cover01l.atn 

and cover01p.atn, cover02l.atn and cover02p.atn, and so on). You can either rename 

your source files to fit this requirement or modify the AML code (this should not be 

very tough). Run the code with all the files located in your working space by typing: 

Arc: &run tingen.aml 

ArcView 

You need to have ArcView version 3.0 or later running with the 3D Analyst 

extension to support surface modeling and 3D visualization. Import the data stored in 

the GENERATE using File/Import Data Source... and choosing the 3D Generate 

File from the menu. Notice that ArcView allows importing data stored in different 

formats. Click OK to confirm your selection. 
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Choose Points as the type of input generate file you are importing and click OK. 

Select the generate file with the points from your working directory and click OK 

again. Once you enter the name of the output shapefile you can click OK one more 

time to start importing the file. Select Yes to add the shape file generated to the View.  

 

Repeat these steps to select the file with the information corresponding to the 

breaklines by selecting Lines as the type of input generate file. You should be able to 

see something similar to this: 
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The next step is the generation of the TIN. With both themes active, select Create 

TIN from Features... from the Surface menu. The Create new TIN window will 

appear and the following fields will have to be specified for each active theme. 

The Height source field specifies what field, if any, is used to provide height values 

for the theme. The value <none> can be used for representing features like area 

boundaries. 

The Input as field specifies what surface feature type the theme will be added as. 

Check that the value selected for the points shapefile is Mass Points, and the one 

corresponding to the breaklines shapefile is Soft Breaklines or Hard Breaklines, 

depending on the case. Notice that, if you have both kinds of breaklines in the same 

file, they will be treated either as Soft or Hard Breaklines according to your selection. 

Thus, it might be necessary to create two different GENERATE files for each kind of 

breakline. This is not necessary if you use ArcInfo to create the tin. 

The Value field specifies what field, if any, is used to provide values for nodes or 

triangles. If the output type is mass point, the values will be assigned to nodes. If the 

output type is polygonal, the values will be assigned to triangles. Values are stored 

with the TIN data model and can be used later for display, query, and modeling 

purposes. 

Click OK and type the name of the tin. After some calculations, a new theme will be 

added to your view with the tin. It should look similar to this: 
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As you can see, all the breaklines in the theme are represented as soft breaklines. This 

is because both type of breaklines were stored in the same GENERATE file and the 

corresponding Input as field was specified with a Soft Breaklines value. As stated 

before, two files would have been required to avoid this problem. The result of 

processing the same files with ArcInfo is shown below. In this case you can see both 

soft and hard breaklines. 
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8 Appendix C: Data Dictionary 

Data Description Class Attribute Units 

100.precip HEC-HMS 
precipitation file for 
a 100-year design 
storm 

Text file   

12_hour.control HEC-HMS control 
specifications file 

Text file   

311100*l Shapefile with 
breaklines for 
Austin 

PolylineZ Elevation Feet 

311100*p Shapefile with mass 
points for Austin 

PointZ Elevation Feet 

311100*l.atn Generate file with 
breaklines for 
Austin 

Text file X, Y, Z Feet 

311100*p.atn Generate file with 
mass points for 
Austin 

Text file X, Y, Z Feet 

accum_m Flow accumulation Grid Value Drainage area 
measured in 
cells 

addAsOutlets Shapefile with the 
outlets/junctions 
manually added for 
the analysis of 
Waller Creek 

Point Id  
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Data Description Class Attribute Units 

aus_clip DEM clipped for the 
Waller Creek area 
projected in 
StatePlane, Zone 
5376, Datum 
NAD83, Spheroid 
GRS1980, Units 
FEET, Zunits FEET 

Grid Value Feet 

aus_sp DEM clipped for the 
Waller Creek area 
projected in 
StatePlane, Zone 
5376, Datum 
NAD83, Spheroid 
GRS1980, Units 
METERS, Zunits 
METERS 

Grid Value Meters 

austin_sp DEM for Austin 
projected in 
StatePlane, Zone 
5376, Datum 
NAD83, Spheroid 
GRS1980, Units 
FEET, Zunits FEET 

Grid Value Feet 

austin_utm DEM for Austin 
projected in UTM, 
Zone 14, Datum 
NAD83, Spheroid 
GRS1980, Units 
METERS, Zunits 
FEET 

Grid Value Feet 
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Data Description Class Attribute Units 

Bppf_* Shapefile with the 
bounding polygons 
generated for the 
floodplain analysis 

Polygon Profile_id  

Bufbuild3d Shapefile 
representing the roof 
of the buildings, 
formed by buffered 
polygonds 

PolygonZ Elevation Feet 

Buffer Shapefile 
representing the roof 
the buildings 
projected in 2D, 
obtained from 
Build-proj using the 
script BufferElev 

Polygon Elevation Feet 

BufferElev.ave Avenue script for 
buffering polygons 
horizontally 

Text file   

Build-base Shapefile 
representing the 
base of the 
buildings, formed by 
converting a 2D 
Polyline into a 
PolygonZ using the 
elevation of the 
terrain 

PolygonZ Elevation Feet 

Build-proj Shapefile 
representing the 
base of the buildings 
projected in 2D, 
provided by CAPCO 

Polygon Elevation Feet 

Build* Shapefile of Austin 
buildings 

Polygon Elevation Feet 
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Data Description Class Attribute Units 

burned_m DEM raised by 5000 
m everywhere 
except in the streams 

Grid Value Meters 

c311100*l Clipped shapefile of 
Austin breaklines 

PolylineZ Elevation Feet 

center_m Stream network 
obtained from 
streaml_m following 
the stream_m grid 

Polyline   

center_m Waller Creek  
stream network 
provided by the City 
of Austin 

Polyline   

Centerline Shapefile of the 
stream centerlines 
used in the AVRas 
analysis of Waller 
Creek 

PolyLine Is_outlet 
Length 
Reach_id 
Stream_id 

 

Centerline3d Shapefile with the 
3D representation of 
the stream 
centerlines used in 
the AVRas analysis 
of Waller Creek 

PolyLineZ   

Cross Shapefile of the 
stream cross-
sections used in the 
AVRas analysis of 
Waller Creek 

PolyLine   
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Data Description Class Attribute Units 

cut-fill 15 ft cell size grid 
with the water and 
terrain elevations 
comparison 

Grid Value Feet 

fa* Shapefile 
representing the 
flooded areas 
corrected from the 
fa?? files 

Polygon   

filled_m Filled DEM based 
on burned_m 

Grid Value Meters 

Flow_m Flow direction Grid Value Arc/Info flow 
direction code 

flowpath Shapefile of the 
flowpaths used in 
the AVRas analysis 
of Waller Creek 

PolyLine  Feet 

Fppf_* Shapefile 
representing the 
flooded areas 
obtained from 
AVRas 

Polygon  Feet 

gages.apr ArcView project for 
the Waller Creek 
AVRas analysis 

Text file   

gages.shp Shapefile of the 
Waller Creek 
junctions defined in 
CRWR-PrePro used 
in the AVRas 
analysis 

Point  Feet 
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Data Description Class Attribute Units 

hec*.dbf Tables for attribute 
transfer from 
ArcView shapefiles 
tinot HEC-HMS 
basin files 

DBF file   

Lines Shapefile breaklines 
obtained from 
Lines2d by 
assigning them the 
height of the terrain 

PolyLine   

Lines2d Shapefile breaklines 
modified by erasing 
those located within 
the polygons 
representing the 
bases of the 
buildings 

PolyLine   

link_m Stream network 
links of the Waller 
Creek watershed 

Grid Value  

lfp_m Longest flow path 
calculated for each 
sub-basin 

Grid Value  

lulc_m Shapefile of the 
Waller Creek area 
land use according 
to the USGS 

Polygon Lucode Anderson’s 
land use code 
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Data Description Class Attribute Units 

moutlet_m Outlets calculated 
for the Waller Creek 
basin considering 
the junction added 
manually 

Grid Value  

mstr_m Stream network for 
Waller Creek based 
on center_m 

Grid Value  

outlet_m Outlets calculated 
for the Waller Creek 
basin before 
considering any 
junction added 
manually 

Grid Value  

prepro04.apr ArcView project for 
the Waller Creek 
PrePro analysis 

Text file   

pf*cs Shapefile with the 
cross-sections 
specifying the water 
surface elevations 

PolyLine Pf_?? Feet 

Reduced 2D 2D floodplain 
animation for the 
UT Campus 

GIF file   

Rivlin_m Shapefile with the 
river network 
determined from 
centerl_m 

PolyLine Length 
WshCode 
StreamVel 
MuskX   Route  
MuskK 
LagTime 
TimeStep 
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Data Description Class Attribute Units 

stream_m Stream network for 
Waller Creek based 
on a 500-cell 
threshold 

Grid Value  

streamp.txt Table with the 
stream parameters 

Text file Muskingum X 
Stream veloc. 

                           
m/s 

structures Shapefile of the 
structures located 
along the main 
stream of Waller 
Creek, obtained 
from field surveying 

Point Field_id Feet 

testhardfill TIN with embedded 
building for the 
Campus of UT 

TIN Elevation Feet 

Trans* Shapefile of Austin 
transportation 
network 

Polygon  Feet 

UT 2D.gif 2D floodplain 
animation 
corresponding to the 
UT Campus 

GIF file   

UT 2D.avi 2D floodplain 
animation 
corresponding to the 
UT Campus 

AVI file   

UT 3D.gif 3D floodplain 
animation 
corresponding to the 
UT Campus 

GIF file   

UT 3D.avi 3D floodplain 
animation 
corresponding to the 
UT Campus 

AVI file   
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Data Description Class Attribute Units 

utm_spm.txt Projection file used 
to project austin_sp 
into aus_sp  

Text file   

Waller.avi 2D floodplain 
animation 
corresponding to the 
Waller Creek 
watershed 

AVI file   

waller.basin Basin file generated 
by CRWR-PrePro 
for the analysis of 
Waller Creek 

Text file   

waller.f01 HEC-RAS flow 
profiles for the 
different junctions at 
different times 

Text file  Cubic feet per 
second 

waller.geo HEC-RAS geometry 
import file 

Text file  Feet 

waller.hms HEC-HMS project 
file for Waller Creek 

Text file   

waller.prj HEC-RAS project 
file for Waller Creek 

Text file   

waller.run HEC-HMS file with 
the Simulate/Run 
configurations 

Text file   

waller_m.map HEC-HMS map file 
for the Waller Creek 
watershed 

Text file   
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Data Description Class Attribute Units 

waller_sp.tif One-meter 
resolution digital 
orthophotographs 
covering the Waller 
Creek watershed 

Image  Feet 

wallertin TIN terrain 
representation for 
the Waller Creek 
area 

TIN Elevation Feet 

Water_m Subwatersheds 
delineated for each 
outlet in moutlet_m 

Grid Value  

watpol_m Shapefile with the 
subbasins 
determined from 
water_m 

Polygon Area, 
Baseflow, 
Transform, 
LossRate, 
CuerveNum, 
LagTime, 
LagMethod 

 

wstinpf_* TIN representing the 
water surface 

TIN   
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9 Appendix D: Scripts 

File Name: buffelev.ave 

 

’Name: BufferElev 

’Type: Avenue script 

’Description: Buffers polygons and assigns the values stored 

’ in the "Elevation" field of the original attributes table 

’ to the buffered features. 

’History: Created by Esteban Azagra and Brad Hudgens 

’Last Modifiation: 09/15/99 

 

theView=av.getactivedoc 

theTheme=theView.GetActiveThemes.get(0) 

polyList={} 

elevList={} 

newFields={} 

theFtab=theTheme.getFTab 

theShapeFld=theFtab.FindField("Shape") 

theElevFld=theFtab.FindField("Elevation") 

 

for each Rec in theFtab 

 thePolygon=theFtab.ReturnValue(theShapeFld, Rec) 

 theElevation=theFtab.ReturnValue(theElevFld, Rec) 

 newPolygon=thePolygon.ReturnBuffered(-(1/10)) 

 polyList.add(newPolygon) 

 elevList.add(theElevation) 

end 

 

’Here you create the feature table. 

’Assign a name and make it for polygons. 
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newName=FileName.make("Buffer") 

newFtab=FTab.MakeNew(newname,POLYGON) 

 

tabFields=list.make 

tabFields.add(field.make("ID",#field_long,12,0)) 

tabFields.add(field.make("Elevation",#field_decimal,6,2)) 

 

newFtab.AddFields(tabFields) 

newFtab.seteditable(true) 

 

newShapeFld=newFtab.FindField("Shape") 

for each Item in polyList 

 newRec=newFtab.addRecord 

 newFtab.setvalue(newShapeFld, newrec, Item) 

end 

 

newElevFld=newFtab.FindField("Elevation") 

nCount=0 

for each EleVal in elevList 

 newFtab.setValue(newElevFld, nCount, EleVal) 

 nCount = nCount + 1 

end 

 

newFtab.seteditable(false) 

newTheme=Ftheme.make(newFTab) 

theView.addTheme(newTheme) 

 

File Name: TINGen.aml 

 

/* TIN generator 

/* Created by Esteban Azagra 06/11/99 

/* The following AML script creates TIN coverages from point and lines atn files. 
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/* All source files must be in the ArcInfo working directory. 

 

/* Reads the files on the directory and creates two files for points and lines. 

&sv lines := [filelist *l.atn lines.txt -file] 

&sv points := [filelist *p.atn points.txt -file] 

 

/* Open both files and checks that the 

/* number of lines in both files is the same. 

&sv file1 = [open lines.txt openstat -read] 

&sv done1 = [null [read %file1% readstat]] 

&if %done1% &then 

 &return &warning The lines file is empty. 

&else  

 &do count1 = 1 &repeat %count1% + 1 &until %done1% 

 &if [null [read %file1% readstat]] &then  

 &sv done1 = .true. 

&end 

&sv closestat = [close %file1%] 

 

&sv file2 = [open points.txt openstat -read] 

&sv done2 = [null [read %file2% readstat]] 

&if %done2% &then 

 &return &warning The points file is empty. 

&else 

 &do count2 = 1 &repeat %count2% + 1 &until %done2% 

 &if [null [read %file2% readstat]] &then 

 &sv done2 = .true. 

&end 

&sv closestat = [close %file2%] 

 

&s diff = %count1% - %count2% 

&if %diff% <> 0 &then 
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 &return &warning Number of files is not coincident. 

&else 

 &do 

 &sv .counter := %count1% 

 &type Starting the generation of %.counter% TIN 

 

/* Opens both files. 

&sv file1 := [open lines.txt openstat1 -read] 

&sv file2 := [open points.txt openstat2 -read] 

&if %openstat1% <> 0 &then 

 &return &warning Error opening lines file. 

&else &if %openstat2% <> 0 &then 

 &return &warning Error opening points file. 

 

/* Read from files 

&setvar .line := [read %file1% readstat1] 

&if %readstat1% <> 0 &then 

 &return &warning Could not read lines file. 

&setvar .point := [read %file2% readstat2] 

&if %readstat2% <> 0 &then 

 &return &warning Could not read points file. 

 

&do &while %readstat2% = 0 

/* Calls create_tin to generate the TIN 

&call create_tin 

/* Read next line. 

&setvar .line := [read %file1% readstat1] 

&setvar .point := [read %file2% readstat2] 

&end 

 

/* Closes files and exits. 

&if [close %file1%] <> 0 &then 
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 &return &warning Unable to close lines file. 

&else &if [close %file2%] <> 0 &then 

 &return &warning Unable to close points file. 

&type  

&type TINs created successfully!! 

 

/* Kills variables and temporary files 

&delvar –all 

&if [delete lines.txt] = 0 &then 

&if [delete points.txt] = 0 &then 

 &type Temporary files erased 

&else &type Unable to delete files 

&end 

&return Process completed 

 

/* Creates a TIN for each pair of files 

&routine create_tin 

/* &setvar n := _tin 

/* &setvar number := [before %.line% l.] 

&setvar tin := [before %.line% l.] 

/* &setvar tin := %number%%n% 

createtin %tin% 

generate %.line% line 

generate %.point% point 

end 

&return 
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10 Appendix E: How to create Animated Flood Maps 

Prepared by Esteban Azagra 
Center for Research in Water Resources 

December 1999 
 

Background 

The generation of computer animations can be very useful for representing time series 

events. This document describes the generation of animated movies for floodplain 

representation. The approach utilizes images generated by ArcView 3.1 working with 

the AVRas extension for floodplain analysis. 

Software Requirements 

Animated movies are created from a series of frames representing the events you are 

going to animate at different times. These frames have to be linked together using 

special software, including some shareware programs (i.e. Animagic GIF Animator or 

GIF Movie Gear) that can be downloaded from Internet. This example uses an 

evaluation copy of the GIF Movie Gear program. 

If you need to “capture” your frames from the computer screen, you may need a 

screen capture program, also available through Internet as freeware or shareware. For 

this example, we are going to use images exported directly from Arc/View and this 

additional software will not be necessary. 

Exporting Images from Arc/View 

Before exporting the different frames that will make the movie, you must ensure that 

all of them have the same size. This is important to obtain a smooth transition 

between frames. The best way to garuantee this in ArcView, is to create a layout with 
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the frame you are working on, and to export it using the File/Export…  command 

with the layout window active. ArcView allows you to export the image in different 

formats (i.e. Placeable WMF, Windows Bitmap or JPEG), most of them compatible 

with the software used to create the animations. 

You have to repeat this process for every frame you want to export in order to create 

the movie. For a floodplain map representation, each flow value generates a different 

floodplain map and, consequently, a potential frame for the animation. Remember 

that the number and size of the frames are directly related to the size of your movie. 

This is specially important if you want to place your animation in a webpage that will 

have to be accessed via modem. 

Importing Images into the Movie Generator Software 

Once you have saved all the frames, you need to import them into the software you 

chose to create the animation. The figure on next page shows some of the jpg frames 

created by ArcView and imported into GIF Movie Gear, corresponding to a 

floodplain simulation at the University of Texas Campus, Austin. 
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Before creating the movie, you can run some of the optimization features provided by 

these programs. These processes delete repeated pixels in the frames and reduce the 

size of the resulting files considerably. 

You can then create the movie and save it choosing one of the formats and 

compression capabilities provided by the program you are using. If you want to 

publish your movie through the Internet, you will probably want to create an 

animated GIF. If you are thinking about using the animations as part of a slide 

presentation, you may want to export it as an avi file. 

The examples included with this document (see Appendix C) will give an idea of the 

things you can do. You can also have a look to some animations at the website 

http://www.ce.utexas.edu/prof/maidment/grad/azagra/Research/Movies/Reduced2D.gif. 
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